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Summary

The Hazardous Material Life-Cycle Cost (HMLCC) Model was developed to estimate the total

life-cycle costs of using various hazardous materials in the construction, maintenance, and repair

of U.S. Naval systems and facilities. The model estimates those costs derived from the need to

protect the health and safety of workplace personnel and the need to protect the environment.

The purpose of this guide is to provide users with a detailed description of the system as well

as the basic structure and features of the HMLCC Model and instructions on how to use the

system.
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Section 1 Introduction

1.1 Purpose of the Hazardous Material Life-Cycle Cost Model

In 1987, the Chief of Naval Operations (CNO) instructed all Navy commands to
reduce the amount of hazardous waste by 50 percent by December, 1992, using
1987 levels as their baseline [1]. To accomplish these goals Navy personnel are
implementing management control practices and up-to-date technology. The
Hazardous Material Life-Cycle Cost (HMLCC) Model was developed to assist
Navy personnel in conducting cost analyses when making decisions about the
procurement of various hazardous materials. The HMLCC Model aggregates the
costs derived from actions taken to protect the health of the worker or to preserve
the environment when a particular hazardous material is used.

1.2 Cost Factors

The primary cost of using non-hazardous materials is procurement cost; however,
when using hazardous materials (HM) added expenses are incurred because of the
need to protect the individual's health and the environment. The added expenses
that elevate the basic procurement cost of a material can be grouped into a set of
cost factors. Cost factors identified by interviews with experts in the field (see
The System Managers Guide) were included in the initial HMLCC model. These
are as follows:

Claims and Processing claims, monitoring cases, conducting
Compensation interventions to resolve problems, assessment of

liability, and providing appropriate payment.

Disposal Discard, permanent containment, or treatment to
eliminate the toxic potential of a hazardous
substance, product, or waste.

Engineering Construction, maintenance, and repair of structural
Controls equipment used to prevent personal and

environmental exposures to hazardous materials.

Fines and Penalties Costs incurred because of federal, state, or local
safety and environmental regulatory violations,
including improper or incomplete recordkeeping,
unsafe working conditions, and environmental
pollution.
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Medical Surveillance Medical consultations, examinations, tests, and
procedures, including baseline and periodic, as well
as event driven medical encounters.

Medical Treatment Medical care for occupational injuries or illnesses
due to exposure to a hazardous substance, product,
or waste.

Permits and Local, state, and federal permits required for

Certification transportation, storage, and use of certain hazardous
materials at a facility.

Personal Protective Gear that is issued to individual workers to prevent
Equipment (PPE) exposure to hazardous materials, including

maintenance, inspection, distribution, replacement,
and inventory.

Procurement The initial cost of the material.

Spill Containment Responses to spills of hazardous materials including
and Cleanup costs of equipment and personnel.

Storage Storage of the hazardous material before use and
storage of any resulting hazardous waste before
disposal.

Training Instructions regarding the legal requirements
pertaining to hazardous materials, and information
regarding methods and procedures for minimizing
the risk of exposure to a hazardous material.

Workplace Surveys, inspections, and monitoring of workplace,
Monitoring processes, materials, and personnel for the purpose

of maintaining the health and safety of workers, and
to protect the environment.
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1.3 Cost Elements

Cost factors are broad categories of individual cost components that make up the
total HM use cost. Cost elements are sub-categories of cost factors. Cost
elements make up the cost factors, similar to the way cost factors make up the
total HM use cost. For example, personal protective equipment (PPE) is a cost
factor, however, there are many different kinds of personal protective equipment
such as, gloves, respirator, and boots. These are the cost elements for the cost
factor PPE. Thus, the cost of a factor is computed as the summation of the cost
elements associated with the factor.

1.4 Cost Items

The expenditure for a cost element depends on the specific item acquired. For
example, gloves may cost between $1.00 and $25.00 per pair depending on the
type of glove purchased. The various products used to meet the requirement of
a cost element are called cost items. Each cost item has a unique price.
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Section 2 HMLCCM Software Summary

2.1 Programming Language

The HMLCCM Software was developed using FoxPro. FoxPro is a database
management system created for the personal computer.

2.2 Security/Privacy

The security module will maintain user passwords which allow logon access to the
HMLCCM program and database files. Menu options are assigned to the user
through a security key system in FoxPro. HMLCCM does not collect or store
Privacy Act data.

2.3 Maintenance

The primary maintenance functions consist of security, file and format definition,
user file updates, and data initialization.

2.4 System Organization

The HMLCCM has four modules or user options (described in Section 4), which
include Cost Analysis, Reference, Set Parameters, and System Maintenance. To
access the Set Parameter option a password is required.
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Section 3 Accessing the System

3.1 Logon to HMLCCM

At the MS-DOS prompt, (C:\-JIMLCCM) type HMLCCM and the security prompt
will display:

PASSW I ORD

Type in the password and press "Enter" or "Carriage Return" <CR>. If the
password is unknown press <CR>. The password allows the user to access the
set parameters option. If the user is unable to provide the appropriate password,
reference, maintenance, and cost analysis will be the only options accessed. A
brief greeting will display before the following "desktop" appears:

The parts of the menu system are shown on page 6, along with steps for choosing menu options
with the keyboard and mouse. If your System does not have a mouse you will need to use the
keyboard.
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3.2 Choosing Menu Options with the Keyboard

Selecting Menu Pads and Menu Options are executed differently when using the
keyboard. The following are instructions on how to select Menu Pads and Menu
Options with the keyboard.

3.2.1 Selecting Menu Pads

There are four Menu Pads available to the user: System, File, Edit and Window
Press the Alt key in conjunction with the frst letter of the menu pad you want to
select. For example if you want to access the File menu pad press Alt F.

3.2.2 Selecting Menu options

A Menu popup appears, containing a list of menu options, when a particular menu
pad is selected. There are two ways to select a menu option using the keyboard:

1. Press the T or Il keys to highlight the desired Menu Option
and press <CR>.

2. Type the bold letter of the Menu Option you want and press <CR>.

Menu Pad

F1o

Systemn File Sd.tWindow
Menu Printer Setup..
Bar Menu Popup-p Print...

i - Menu Opti.o

3.3 Choosing Menu Options with the Mouse

1. Point to the menu pad and press the Left mouse button to display
the menu popup.

2. Point to the desired option and press the Left mouse button.

Accessing the System 0 1 6



3.4 Logout of HMLCCM

To return to the MS-DOS prompt

1. Choose Quit from the File menu pad.

______________ ii. -- _______________________ t:

Printer Setup

Print...
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Section 4 Systems Operation

4.1 Cost Analysis

To calculate how much it will cost to use a particular hazardous material you will
first need to define the circumstances in which the substance will be used. For
example, you may use 5 gallons of lead-based paint or 4 gallons of PD-680.
Specification of the circumstances for using a hazardous material is called the
hazardous material scenario. Each scenario consists of one or more steps. For
each step of a scenario, a material, phase, process, number of people, number of
days, and quantity of material must be defined. To create a scenario follow the
instructions outlined below.

1. Choose HMLCCM from the System menu pad.

An option menu will appear on the screen.

2. Choose Cost Analysis from the option menu.

This will direct you to the Build Hazmat Scenario prompt as shown below.

Sy~ti~ ileEdit'

Help... Fl

Calculator

W4ii iLCQE *iii i0-1 ýlAiMs i A4 i i T i

Reference

System Maintenance

Set Parameters

3. Press <CR>.

The following box will appear:

Cost Analysis

Scenario:

<Now> <Retrieve> <Delete> <Browse> <Cancel>
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You are now in the Cost Analysis option. There are two things you can do. You
can either define a new scenario or retrieve an already existing scenario.

4.1.1 Define a New Scenario

1. Type in a file name and press <CR>.

The cursor should default to the sub menu below
and highlight New.

2. Select New from the sub menu below and press
<CR>.

The following screen will display:

HAZARDOUS MATERIAL SCENARIO

Step # 1 Scenario: 1 Example

Material : < - >
Phase: < Edit >
Process: • Next o

<Previous>
< Exit >

Number of Employees: Number of days:
Quantity of material: Unit:

< Save > <Cancel>

Note: The users can only input materials, phases and processes that have
previously been defined. To insure that you are using an item that
has previously been defined type ? <CR> to access the list of
choices.

3. Type in the name of the hazardous material used
and press <CR>.

4. Type in the phase and press <CR>.

5. Type in the process and press <CR>.

6. Type in the number of employees who performed
the process and press <CR>.
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7. Type in the number of days that the process took to
complete and press <CR>.

8. Type in the quantity of material used in the process
and press <CR>.

Note: The unit of material is defined when the material is
defined, therefore, the unit will never need to be
input at the hazardous material scenario screen.

9. Select Save on the sub menu below and press
<CR>.

10. Select Exit on the side menu and press <CR> (Skip

to Section 4.1.3 step 5).

4.1.2 Defining a Scenario with Multiple Steps

A scenario consists of one or more steps, where each step specifies
a material, phase, process, number of people involved, the duration
of the task, and quantity of material. Steps enable the user to
calculate costs for the separate components of a complex process.
For example, one may want to determine the cost of painting an
airplane where both the construction cost and maintenance cost are
of interest. The components or steps of this process might include
applying the paint during construction, and then stripping and
repainting during the maintenance phase. Therefore, the hazardous
material scenario would consist of the following steps;

Step 1: Step 2:
Material: Lead paint Material: Methylene chloride
Phase: Construction Phase: Maintenance/Repair
Process: Spray Painting Process: Paint stripping

Step 3:
Material: Lead paint
Phase: Maintenance/Repair
Process: Spray painting

Once you have identified the steps you will need to enter them into the HMLCC
model.
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First follow the instructions in 4.1.1 (Define a New Scenario) for entering in step
1. After you have defined a scenario you will notice that at the top left comer
will be Step 1 and the top right comer will be the scenario name. To create
another step follow the instructions below:

1. At the scenario dialog box, select the scenario you just created by
typing in the name.

The Hazardous material scenario material dialog box will appear
on the screeen.

2. Select Add on the side menu.

3. Input the material, phase, process, quantity of material, number of
employees and days.

After you have done this you will notice that the step is now #2.

4. Select Save on the sub menu below and press <CR>.

5. Select Exit on the side menu and press <CR> (Skip to section
4.1.3 step 5).

4.1.3 Retrieving a Scenario

If you do not want to define a new scenario, you have the option of accessing a
scenario in the database that has been previously defined. To retrieve a scenario
that already exists follow the instructions below.

1. Type ? <CR>

A list of all the scenarios in the database will appear on the screen (shown
below).

Se1~SystemaOperationeI at11
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2. Select by using the T or I, keys until the scenario

you want to retrieve is highlighted.

3. Press <CR>.

The cursor will default to the sub menu below and
highlight retrieve.

4. Select retrieve and Press <CR>.

A dialog box will appear asking you if you want to
do computations now.

5. Press Yes and <CR>.

The following box will display:

COMPUTE COST VALUE

Estimated Estimated
Cost Scenario: 1 Example Variance

for step:

[ ] for Factor: [ ]

for Factor: at step: [ ]

for Phase: CONSTRUCTION [ ]

# uf it rations Total of Scenario cost: C ) Yes ( ) No

< OK > <Browse> <Cancel>

Note: For a review of the terms used on this menu see Appendix A.

4.1.4 Selecting Computation Options

This option allows the user to calculate the estimated cost of a scenario or a
portion of a scenario. In addition, the user can derive variance for the cost
estimate using a bootstrap analysis.
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4.1.4.1 Cost Estimate

The cursor will appear in the first cost box. If you
are using a keyboard use the +- and --+ keys to
move to the next option.

The following list describes the functions of each of
the cost boxes.

Cost box 1: Computes the estimated cost for all steps in the
scenario or only one step.

Cost box 2: Computes the estimated cost for factors across all
steps.

Cost box 3: Computes the estimated cost for a particular factor
at a particular step.

Cost box 4: Computes the estimated cost for a particular phase.

If you are interested in the total scenario cost, for example the total
cost to paint an airplane, select the "Total of scenario cost" radio
button at the bottom of the screen.

For selecting the cost computation option follow the instructions
below;

1. Select the cost box on the left side of the screen by positioning the
cursor on the box and pressing <CR>.

2. Move the cursor to the option box parallel to the compute box and
press <CR>.

A dialog box will appear displaying your options.

3. Highlight the option you want and press <CR>.

Note: If your scenario includes more than one step and you have defined
these steps you will have the option to compute cost for all the
steps or for only one of the steps. If you have not defined more
then one step you will only be able to compute for that particular
step.
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4.1.4.2 Selecting Variance Options

The variance box allows the user to conduct a bootstrap analysis to
determine the variance of a cost estimate. The results are presented
as the mean and standard deviation of a set of samples. The user
determines the number of samples by specifying the number of
iterations.

Note: The system will only allow you to estimate the
variance of one cost factor at a time.

For selecting a variance option follow the instructions below:

1. Move the cursor to the variance box and pitss
<CR>.

Finish selecting any cost options before you continue.

2. Select the # of iterations by entering the number in
the box to the left and press <CR>.

Note: the default value for iterations is 200. Using this
value will require several minutes of compute time.
The user may select a smaller value if desired,
however, larger values will yield more accurate
estimates.

3. Select <OK> on the sub menu below and press
<CR>.

A dialog box will appear with several variance
options.

4. Select by highlighting the option and press <CR>.

A message window will appear with "Calculating" in the box until
the estimated cost and variance results appear.
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4.2 On-Line Hazardous Materials Reference

An on-line reference option is available which allows the user to retrieve
information, such as; Synonyms/Trade names, Common uses, Descriptions,
Chemical/Physical properties, Occupational exposures, Exposure limits, Health
hazards, Medical surveillance, Special tests, Personal protective equipment, and
Treatments. To access this information follow the steps below.

1. Choose HMLCCM from the System menu.

An option menu will appear on the screen.

2. Choose Reference from the option menu.

_______:. _ _E-- Edit E .

Help... Fl

Calculator

..14onx CM cost Analysis

System Maintenance

Set Parameters

The following box will appear:

MATERIAL:

nter a erla or . or e p

< Ok > <Cancel>

3. Type ? and press <CR>.
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A list of all the materials in the database will appear on the screen (shown below).

Select ba Material

1~1 1-RIClHLOROP.THANE
2-THXYNT1ALOL

Il~MO COMPOUNDS

6. SelectlO an rss <R>
.. .. .. ... . .

4. Select by using the tor . keys until the material you want is highlighted.

5. Press <CR>.

The cursor will default to the sub menu below and highlight OK.

6. Select OK and press <CR>.

The screen will display the hazardous material you selected and the
information divided into the 11 subcategories previously mentioned.
To scroll down the screen use the T and ,I, keys.

4.2.1 Print On-line Reference Information

Occasionally you will want to print the reference information that
appears on the screen to do this follow the instructions below.

At the on-line reference screen;

1. Press shift and tab at the same time to move the
cursor to the sub menu below.

2. Select Print and press <CR;,.

4.2.2 Exit On-line Reference

1. Press shift and tab at the same time to move the cursor to
the sub menu below.

2. Select Exit and press <CR>.
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4.3 Maintenance

Occasionally you will want to back-up your files onto floppy disks or to up-load data that
was done on another computer. To perform these functions follow the instructions listed
below:

4.3.1 Backing-up your files

1. Choose HMLCCM from the System menu.

An option menu will appear on the screen.

2. Choose System Maintenance from the option menu.

Another option menu will appear on t.he screen.

3. Choose Back-Up (floppy) from the option menu (shown below).

The computer will prompt you to insert your diskette. Put your diskette in drive
A and follow the computer's directions.

Help... FI

Calculator

Cost Analysis

Reference

Set Parameters Up-Load Data

4.3.2 Up-loading data

1. Put a diskette in drive A.

Follow the Computer's directions.
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4.4 Set parameters

To access the set parameters options the user has to provide a password when
logging onto the system. For instructions on setting parameters see the system
manager's guide.
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Section 5 Menus

The HMLCCM commands appear in two Menus; System and File. The Edit and
Window menus contain commands that the user will not need to access.

System Vile ,dit window

A command is an instruction to your computer to carry out an action, such as
printing a document. When you pull down a menu, you will notice that some
commands appear in dark text while others are dimmed. You can use the
commands in dark text immediately, but you cannot choose a dimmed command
until it becomes dark.

5.1 The System Menu

The System menu contains the commands for logging on the HMLCCM system
and the desk accessories such as the Calculator and Help.

Help.... F1l

Calculator

HMLCCM

5.1.1 Help

The HMLCCM system offers on-line help. The help contains
instructions describing all the HMLCCM functions. To access
Help select Help from the System menu or press Fl. A Help
window will display with general topics, commands, and functions.
The help window can be scrolled by using the arrow keys on the
keypad. To find the topic you want, you can scroll through the list
or, while you are in the Help Window, type a letter or series of
letter to select the first list item beginning with the specified
letter(s).
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5.1.2 Calculator

The system has a four-function pocket calculator that will appear on the screen
when you select calculator from the system menu. The Calculator is used like a
standard pocket calculator.

Calculations can be performed using the keyboard or the mouse.

Calculator

MC 7 8 9 / "

MR 4 5 6 *%

M+ 1 2 3 - C

M- 0 ± + =

With the keyboard, you can type the equation as it would be written. Most Calculator
keys have the same keyboard equivalents, with the following exceptions:

Keystroke Equivalent

Q _ _

R MR

N +

A M+
Z MC

S M-

To calculate 8 X 16 + 23 and take the square root of the result using the
keyboard:
Type 8*16+23=Q The result is 12.28.

To perform the same calculation with the mouse, simply click on the appropriate
numbers and symbols on the Calculator.
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5.1.3 HMLCCM

This option allows the users to access the system. The system contains four
options which are; Cost Analysis, Reference Materials, System Maintenance, and
Set Parameters.

5.2 The File Menu

The file menu contains the commands for printing documents, and ending a work
session.

Printer Setup
Print.....

Quit

5.2.1 Printer Setup

Printer Setup... displays the Printer Setup dialog.

Printer setup:

Print to: PRN

<File... >

Print on Left Margin:
(.) Print Of f Right Margin:

< OK > <Cancel>

In this dialog, you can choose a print device from the Print to popup. If you
choose File from the popup, you could specify a file to which output will be sent.
To do this, type a file name in the text box.

Adjust the settings for left margin and right margin, if necessary.

Choose the Print on and Print off radio button to enable or disable output to the
printer.
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When your settings are correct, choose OK to activate them or choose Cancel to
exit the dialog with out changing the current print settings.

5.2.2 Print....

When you select "Print" form the File menu, the Print dialog displays the
following menu:

Print:

Windows: [ iJ

<File... >

[]Line Numbers
[I Page eject before
[x] Page eject after

< Ok > <Cancel>

Choose the source from the Windows popup. To print the contents of a file that
is not currently open, choose the File option from the Windows popup. Then,
in the text box, type the name of the file you want to print.

When the Line Numbers check box is checked, HMLCCM automatically adds
line numbers to the output.

When the Page eject before check box is checked, HMLCCM sends form feed
to the printer before printing. When the Page eject after check box is checked,
HMLCCM sends a form feed to the printer after printing.

Once the settings in the print dialog are correct, choose OK to confirm your
choices or Cancel to exit the dialog without taking action.

5.2.3 Quit

Quit ends your HMLCCM session and returns you to the system
prompt.
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Appendix Terms and Abbreviations

Browse to display data in a Browse window.

Bootstrap A method for estimating the variance of a variable from a set of observed
values.

Carriage Return
<CR> A command that is usually accessed by the Return key or

the Enter key.

Check box A pair of square brackets followed by text. Settings can be turned on and
off by choosing the check box. If a check box has an X in it the setting
is on.

Choose To select a command or an option from a menu, or a control in a dialog.

Default A preset response to a question or prompt. The default is automatically
used by the computer if you don't supply a different response. Default
values prevent a program from stalling or crashing if no value is supplied
by the user.

Desktop The screen that underlies all system and user-defined windows is called the
desktop.

File Any name that identifies a file.

H'ghlight To make something visually distinct. For example, when you select a
block of text, the selected text is highlighted.

Highlighted Text that is emphasized so that it stands out from the surroundings.
Highlighting something typically indicates that it is selected or is about to
be chosen. Highlighted text may appear differently depending on the type
of monitor and color settings that you use.

HMLCC Acronym for Hazardous Materials Life-cycle Cost.

HMLCCM Acronym for Hazardous Materials Life-cycle Cost Model.

HM Acronym for Hazardous Material.

HW Acronym for Hazardous Waste.
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Menu A list of choices presented by a program, from which you can select an
option.

Menu bar A horizontal strip that appears at the top of the screen and contains menu
pads.

Menu options Commands, found on the menu popups, that perform specific actions.

Menu pads A word, phrase or icon on the menu bar that designates one menu.
Positioning the cursor on a menu title highlights the title and display its
options below it.

Menu Popup List of related options. When you choose an option from a menu popup,
you are telling the HMLCCM system what action to take.

Menu system The combination of the menu bar, menu pads, menu popups and menu
options.

On-line help A mini-reference guide, accessible while using the HMLCCM system, that
provides additional information about HMLCCM commands and functions.

Options A list of actions to choose from that are listed on a menu.

Phase A level in the evolution of a system or product (e.g,
construction, or maintenance/repair).

Prompt A message on the screen that tells you of some need for response or
action. A prompt usually takes the form of a symbol, a message, a dialog
box or a menu of choices.

Process The operation or treatment that utilizes the
hazardous f."-terial described in the scenario.

Radio button A set of parentheses followed by text. Radio buttons are grouped so that
only one can be chosen at a time, like the buttons on a car radio. Choose
a radio button to activate it. When a radio button is chosen, a bullet
appears in the parentheses and any previously chosen radio button becomes
deselected.

Scenario The specific circumstances that define how a hazardous material is used.

Step A component of a task that can be defined in terms of the material,
process, and personnel that are required to accomplish the task.
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